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GGEETTTTIINNGG  SSTTAARRTTEEDD  WWIITTHH  MMIICCRROOSSOOFFTT  EEXXCCEELL  

OORRGGAANNIIZZIINNGG  YYOOUURR  WWAATTEERR  QQUUAALLIITTYY  DDAATTAA  
  
Microsoft Excel is one of many readily available resources that can help you organize your water 
quality monitoring data into a manageable, user-friendly format.  Excel allows the user to create 
useful graphs and charts that will help you track and communicate your organization’s water 
quality monitoring results.  In order to use Excel, you must have access to a computer with the 
Microsoft Office suite installed.  This tool is designed to provide an introduction of the basic 
functions that Excel can perform which can aid you in the organization, analysis, and assessment of 
data. 
 
 

 
 

Table of Contents 
 
I. Understanding the Workbook………………………………………………………………………………………….……………………...................2 
 
II. Saving the Workbook………………………………………………………………………………………………………………………………………………2 
 
III. Manipulating and Controlling Cells…………………………………………………………………………………………………………..………3 
 
IV. Copying and Pasting Cells…………………………………………………………….……………………………………………………………………….4 
 
V. Using the Fill Handle Function………………………………………………………………………………………..…………………………………..5 
 
VI. Dragging and Dropping Cells…………………………………………………………………………………………………...…………………………..5 
 
VII. Using and Creating Formulas…………………………………………………………………………………...………………………………………….6 
 
VIII. Sorting Data…………………………………………………………………………………………………………………………………………………………………8 
 
IX. Freezing Panes…………………………………………………………………………………...………………………………………………………………………9 
 
X. Creating Charts and Graphs……………………………………………………………………………………………………………………………….10 
 
XI.          Additional Help……………………………………………………………………………………………………………………………………………….………13 
 
 
 
 
 
 
 
 
 
 
 



2 

 

 
I.  Understanding the Workbook 
When you first launch Excel, the program will ask if you want to open a new, blank workbook.  A 
workbook consists of a series of spreadsheets on which you can organize various projects.  Choose 
to create a new workbook.  An Excel spreadsheet consists of a bunch of columns and rows, which 
form a very large amount of individual cells. 
 
The Top of the Workbook 
At the very top left corner of the window is the “Office” button, which allows you to access recent 
documents, save, open, print, and perform many other functions related to the document itself.  The 
little disk icon to the right of the “Office” button is a quick way to save a document.  At the top 
middle of the document you will notice the name of the document.  Right now, the document has 
not been saved with a name, so it is simply called “Book2”, as seen in Figure 1. 
 
The row immediately below the title contains 8 tabs available for your use, starting with “Home”.  
These tabs contain numerous functions that allow you to manipulate the data you input into 
individual cells. 
 

 
 
 
The Bottom of the Workbook 
At the bottom of a spreadsheet (Fig. 2), you will notice that three different sheets exist.  Each sheet 
is an independent spreadsheet.  It is sometimes useful to have different portions of data in different 
sheets so it is easier to manipulate and keep track of.  You can add more sheets by simply clicking 
on the glowing page icon to the right of the last sheet, in this case “Sheet3”.  You can also rename a 
sheet to whatever you like by double clicking the text with your mouse and then typing in the 
desired name. 
  

 
 
 

 
II.  Saving a Workbook 
 
You can save a document for the first time by either clicking on the save icon (the small disk), or by 
going to the Office dropdown menu and selecting “Save As”. 

a. If you are using an Excel version that is older than 2007, your workbook will save as an 
“.xls” file.  If you are using Excel 2007, then your file will save as “.xlsx”.  It is important to 
note that the older versions of Excel may not be able to open “.xlsx” files.  This is because 
these files may contain advanced formatting or other programming that older Excel 
versions are not compatible with. 

Fig. 1 

Fig. 2 
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b. If you are using Excel 2007 and wish to share the document with someone who has an older 
version, it is recommended that you save the file as an “.xls” file.  You can do this by saving 
the document as an “Excel 97-2003 Workbook” when you click on “Save As”. 
 

III.  Manipulating and Controlling Cells 
 
Cell   
A cell is one rectangle within the entire page of 
rectangles on a spreadsheet.  Each cell is 
assigned a unique reference value.  You can 
select a cell simply by clicking on it with the left 
mouse button.  If you examine the cell selected in 
the Figure 3, you will notice that B and 3 are 
highlighted.  This cell may be referred to as B3.  
 
Selecting Multiple Cells   
You can select more than one cell by holding down your mouse button and dragging.  The area that 
is colored as you drag your mouse is the selected area.  Let go of your mouse button to finalize your 
selection. 
 

a. An alternate method is to first select one cell, then hover your mouse over to another cell, 
and click while holding down the “Shift” button.  This will allow you to select multiple cells 
too (Fig. 4). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Selecting an Entire Column or Row   
1. Point your mouse over one of the letters at the top of a spreadsheet and your mouse will 

turn into a downward-pointing arrow.   
2. When this happens, click and you will have highlighted every cell in the entire column.  The 

same principle applies to the numbers on the left hand side if you want to select an entire 
row, except your mouse will transform into a right-pointing arrow when you mouse is 
hovering over one of the numbers. 
 Dragging will allow you to select multiple columns or rows, similar to selecting multiple 

cells as mentioned earlier.  In Fig. 5, multiple rows have been selected. 
 

Fig. 3 

Fig. 4 

Fig. 4 
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Additional Methods to Manipulate Cells 

1. The “Home” tab provides a large variety of different methods to customize your cell data.  
The following two are the most used functions of the “Home” tab. 
a. The “Font” subsection allows you to adjust size, color, and style of the text within 

each cell. 
b. The “Alignment” subsection allows you to place the data exactly where you want it 

aligned within a cell (i.e. left, center, right).  You can also choose to merge cells 
together and make your text wrap.  Text wrapping is when you have the text within 
the column width of the cell.  If the text does not fit within the individual cell, more 
space is added, allowing for all the text to fit within the cell and be seen by the user. 

2. You can also manipulate the width of all cells within a column by moving your mouse to the 
line separating the column letters at the top of the spreadsheet.  Your standard cursor will 
transform into a cursor with arrows pointing left and right.  Left click your mouse when this 
happens and you can shorten or widen your cell width for that column by dragging the 
column separator to the left or right.  You can also automatically adjust the column width to 
fit the longest piece of data within that column by double clicking the double arrow cursor. 

a. The same kind of operation can be performed to manipulate the height of all the 
cells in a row.  Simply perform the same tasks as above, but between the row 
numbers and adjust vertically. 

 

 

IV.  Copying and Pasting Cells 
 
Copy  

1. Select the cells you want to copy. 
2. Hold down the “Ctrl” button and hit the “c” button to copy the selected area.   

a. You may also perform this function by clicking the right mouse button on the 
selected cell(s) you want to copy, which will bring up a list of tools.  Click on the tool 
that is called “Copy”. 

b. A grid of alternating black boxes will circle around your selection after performing 
the “copying” mechanism. 

 
Paste  

3. Then select the cell where you want to paste the cell(s). 
4. When you have chosen where to paste your cells, hold down “Ctrl” again, and hit the “v” 

button. 

Fig. 5 



5 

 

a. An alternative method is to right click the cell you want to paste, and select the 
“Paste” function.  “Paste” is only available for use within the function box if you have 
already selected a cell or group of cells to copy. 

b. It is important to note that when right clicking on a selected cell, a “Paste Special” 
option can also be chosen, as seen in Fig. 6.  This function is used for more specific 
operations.   

i. The commonly used options seen in Fig. 6 are “Formulas” and “Values”.  If 
you select “Formulas” from “Paste Special”, then the formula you copied will 
be pasted instead of the result.  Pasting “Values” will paste the value only, 
with none of the copied cell’s formatting, formulas, or anything else.  The 
“Formats” choice pastes the format of the copied cell but the actual contents 
of the cell are left untouched. 

 

 
 

 

V.  Using the Fill Handle Function 
 
What is “fill handle”?   
The fill handle function is very useful for populating cells with the same value or formula.   

1.  To use this function, first select the cell you want to use to populate the other cells. 
2. Hover your mouse over the bottom right corner of the cell until your mouse transforms into 

a black plus symbol.   
3. Left click when the plus sign appears, and then drag over the cell areas you want to 

populate with that particular selected value or formula. 
 

 
VI.  Dragging and Dropping Cells 
 
Dragging cells is a means of moving a cell(s) from one area of the spreadsheet to another.  It is 
useful for relocating data, and it is important to note that it is not the same as copying and pasting.  
When dragging cells around, you are completely moving the selected cells from one location to 
another.  You may use this function if you are rearranging your data, while you may choose to copy 

Fig. 6 
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and paste if you wish to have another set of that same data.  It is flexible as to which function you 
choose. 
 

1. Select the cells you want to move. 
2. Hover your mouse anywhere along the border of the highlighted area and the mouse will 

turn into an icon with four arrows pointing in every direction. 
3. Click the left mouse button.  Hold it down and move the mouse to the place you want to 

relocate your data.  Release the button and your information will be “dropped” into your 
desired location. 

 

 

VII.  Using and Creating Formulas  
 
One of Excel’s useful tools is the ability to create and manipulate formulas.  While you are able to 
perform simple mathematical equations such as multiplication or division, more complex functions 
are available.  These include statistical tests such as calculating the mean, maximum, minimum, 
standard deviation, and countless more.  It is highly recommended that you play with the Excel 
formula menu to browse all the possible functions available.  Test out functions you believe may be 
useful for communication of your organization’s water quality data. 
 
Finding Formulas  
Click on the “Formula” tab and you will notice a “Math and Trig” and a “More Functions” button 
(Fig. 7).  Click on either one of those to find a large list of potential functions.  These functions are 
pre-defined, and many of the more complex ones require you to fill out various windows in order to 
use them. 

a. An easy way to find functions and for figuring out which functions to use is to go to the 
Formula tab and click the “Insert Function” button on the far left end, designated by the 
large “fx” icon.  The window that appears allows you to search for a function, or provide a 
description of a function and then provide you with a list of related functions.  It is quite 
handy if you are unsure of what function to use or where to find it! 
 

 
 
 
Creating Formulas  

1. To compose a formula, first select the cell where you want your calculated value (when the 
value within the cell is obtained from an equation) to appear.   

2. Click on the formula bar, which is the long, blank bar right above the column letters, and 
appears to the right of the “fx” symbol (Fig. 8). 

Fig. 7 



7 

 

3. Always begin a formula with an equal “=” sign. 
4. After the mandatory equal sign, you may begin typing your formula.  You can refer to other 

cells within the spreadsheet when making calculations (Fig. 9).   
a. For example, “=AVERAGE(G2:G4)” would provide you the average of the numbers 

within G2, G3, and G4.  Also observe that a predefined function was used in Fig. 9. 
b. To incorporate a range of cells in your formula, as seen in Fig. 9, you simply list the 

first cell you want to include, insert a colon, and then type in the last cell you want to 
include.  The last cell can even be in a different row or column. 
 

 
 

5. Hit the “Enter” button when you are done creating your formula and your function will be 
performed within the designated cell. 

 
Additional Example 

1. In Fig. 10, a database exists with a bunch of quiz scores from three different classes.  We 
want to add up how many students scored well or scored poorly. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. The formula we used is “=COUNTIF(A2:C11, ">8")+COUNTIF(A2:C11, "1")” 

Fig. 8 

Fig. 9 

Fig. 10 
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3. You will notice that a function called “COUNTIF” was used.  This function will count the 
number of times a certain number or range of numbers within your specified database 
occurs.  Unlike the “AVERAGE” function used earlier, this function requires criteria to be 
met.  The database you want to use is still listed first within the parentheses, as seen by the 
“A2:C11” section, but then a criteria is listed within the parameters.  In Fig. 10, any score 
that was higher than an 8 or anyone that scored a 1 on the test resulted in an increase in the 
overall count. 

a. You will typically place your criteria within a set of quotation marks to signify that 
those are the exact values you want to be met.  We wanted any number greater than 
8 to be counted, so we placed a “>” sign to execute that action, resulting in “>8”. 

b. Note: You can contain text as your criteria instead of numeric values too, which 
would allow you to count how many times a certain word appears, for example. 

c. You can insert multiple functions within the same formula, as seen in the Fig. 10 
formula bar.   

 

 
VIII.  Sorting Data 
 
When creating databases, there will be occasions where you want your data to follow a certain 
order.  For example, you have a database full of names and you want to organize the names in 
alphabetical order by last name.  The sorting function allows you to organize your data in various 
different ways. 
 

1. You will need to select the entire spreadsheet first.  This may be done by simply clicking the 
gray box in the upper left corner – the box where the column letters and row numbers meet. 

a. It is important to do this because otherwise your data may become mismatched by 
row or column. 

 
 

 

2. Click on the “Data” tab near the top of the Excel document, and then click on “Sort”.   
3. A window will appear that will allow you to customize how you want to sort, such as sorting 

by specific columns or sorting in an ascending or descending order (Fig. 12).   
a. If you select the “Header Row” button, this will prevent the first row of your data 

from being sorted.  This is helpful if your first row has a title which you don’t want 
to be sorted with your data. 
 

Fig. 11 



9 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Sorting by More Than One Column 
1. Sometimes, you may find out that you want to sort your data by two or more columns.  For 

example, you have a database of first and last names, and you want to sort by last names, 
and then by first names.  When you are in the “Sort” window, click on “Add Level” on the 
upper right corner of the window to add another layer of sorting.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 

2. You will notice that you can sort by last name, and 
then after your database is sorted by last name, 
your data will be sorted by first names.  You can 
keep adding more levels you want to sort by simply 
by clicking the “Add Level” button.   

 
 
 
Note: Be careful when sorting.  You do not want to mismatch your data by sorting only certain rows or 
columns when all of them should have been sorted, or vice versa. 
 

 
 

Fig. 13 

Fig. 14 

Fig. 12 
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IX.  Freezing Panes 
 
When your workbook is filled with data, it may become difficult to keep track of column and row 
headings.  For example, you could be entering data in row number 990 and not be able to see what 
information is needed for column P without scrolling all the way to the top of the spreadsheet to 
look at the header.  Freezing panes is an option that allows you to lock certain rows or columns in 
place so you can refer to them while working within your workbook.  This tool allows you to freeze 
the top row of your spreadsheet which should define each column to input the desired and correct 
information into an individual cell. 
 

1. To freeze panes, click on the “View” tab.  Under the “Window” subsection, click on “Freeze 
Panes”, which is circled in Fig. 15.  You can choose to freeze the top row, first column, or 
customize your freezing. 

2. If you customize your freezing, make sure you have the correct cell selected from where you 
want to freeze.  The columns to the left of the selected cell will be frozen, and rows above 
the selected cell will be frozen.  See Fig 15.  Solid lines will appear to show which panes are 
frozen. 

 
3. You can always unfreeze panes by clicking on “Unfreeze Panes”, which is located within the 

“Freeze Panes” menu. 

 
4. Notice that cell L12 is selected in Fig. 16 and the window has been scrolled down.  By using 

the freeze panes option, you are still able to see the top two rows. 

 

 
 
 
 

Fig. 15 

Fig. 16 
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X.  Creating Charts and Graphs 
 
Making graphs or charts are very useful for discovering and tracking trends in your data.  Graphs 
and charts display your data in a visual manner.  They are a great way to summarize your results 
and make your data much easier to be communicated to individuals outside of your organization. 

1. First, you need to decide which two sets of data you want to compare to each other.   
a. In Fig. 17, we compare temperature versus the dates. 
b. To select two different groups of data that are not adjacent to each other, first select 

one group of data.  Then, while holding down the “Ctrl” button, select the next group 
of data.   

c. If you are using Excel 2007, skip steps 2-4; if you are using an older version of Excel, 
keep reading. 

 
 
 
 
 
 
 
 
 

 
2. Select the “Insert” tab, and then select 

“Chart”.  You will then have multiple 
options for what kind of chart you would 
like to display (Fig. 18). 

 
 
 
 
 
 
 
 

 
 
 
4.   The third window (Fig. 20) allows you to 
customize your graph.  You can fill out your title, 
your axis labels, what type of information you 
want for the legend, and much more. 

Fig. 17 

Fig. 18 

Fig. 19 

Fig. 20 

3.    The next window (Fig. 19) tells you what 

data ranges you are currently using for 

your graph and what your graph currently 

looks like.  You can readjust your data 

range here.  You will typically want your 

graph series to be in “Columns”. 
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5. The last window allows you to 
decide whether you want the 
graph to appear on the sheet you 
are currently looking at, or 
whether you want the graph to 
appear on another sheet within 
the workbook.  Then hit “Finish”. 

 
 
 
 
 

 
Creating Graphs in Excel 2007 version 

1. If you are using the Microsoft XP version of Excel, you will be able to fill out a series of 
windows with various customization options, as shown in the previous example. 

a. If you are using the 2007 version of Excel, the graph will appear immediately after 
you decide on what type of display you want for your graph.  You decide on what 
type of graph you want from a drop down menu (Fig. 21).   

 

 
 

Fig. 21 

Fig. 20 

Fig. 20 
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2. After choosing which graph, your graph will immediately appear.  You can customize your 
graph by going to the “Chart Tools” tab at the top.  This tab only appears if you have a graph 
selected, and will be the right-most tab as seen in Fig. 22.  You can customize how your title 
is displayed and perform any other customization options by clicking on any of the icons in 
the “Chart Layouts”.  The tab at the top also allows you to redesign and reformat your graph 
to tailor the graph to your needs and preferences. 

 
 

XI. Additional Help 
 
This guide has only touched on the basics of Microsoft Excel.  If you need more help or want to learn 
about more complex functions, there is a Help function within Excel.  Click the question mark in the 
upper right corner of Excel, and a window will appear.  You may browse around and find tutorials 
on how to use the many different tools of Excel.  You can also perform searches within the Help 
function so you can find the help that you need in a quicker fashion.  For further information 
regarding Microsoft Excel, you may contact Christopher Chen from EPA Region 9 at 
chen.christopher@epa.gov or call 415-972-3442. 
 
 
 
 
 

Fig. 22 

mailto:chen.christopher@epa.gov
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List of Shortcuts and Definitions 
 
Shortcuts 
To make a selection: Left Click your mouse + Drag Mouse over desired area 
To move your cell selection one cell to the right: “Tab” 
To complete cell and move cell selection down one cell: “Enter” 
To bring up a quick menu of common functions and tools:  Right Click your mouse on specified cell 
Save: Ctrl + “S” 
Copy: Ctrl + “C” 
Paste: Ctrl + “V” 
Undo previous action: Ctrl + “Z” 
Bring up the Find tool (help locate numbers or words): Ctrl + “F” 
Bold/Unbold the contents of the cell: Ctrl + “B” 
Italicize/Un-italicize contents of cell: Ctrl + “I” 
Select entire worksheet: Ctrl + “A” 
Select entire row: Click the number on the far left side of the row 
Select entire column: Click the letter that appears right above the spreadsheet 
To perform a function within a cell: “=” + function or equation 
 
Definitions 
Workbook: An Excel file is called a workbook.  Each workbook contains a spreadsheet.  Each 
workbook may contain multiple pages (or tabs) of spreadsheets, although the default is 3 tabs. 
Freeze Panes:  This is when you lock certain rows and/or columns in place regardless of where you 
scroll within the workbook. 
Fill Handle:  A tool you can use to populate rows or columns with the same value or formula. 
Formula:  When you input an equation into a cell instead of just a value, which will then calculate 
for you the value that will show up within the cell. 
Formula Bar:  The white bar that appears right above the spreadsheet and the column letters.  You 
can see the entirety of the cell contents within the formula bar.  You may type in your formula or 
value within this box. 
Paste Special:  This menu provides many different options for pasting your copied material, such as 
pasting formatting only, pasting formulas only, pasting values only, etc. 
Sort:  A tool you can use to sort your database in alphabetical order, from smallest to largest, by font 
color, and various other means.  Just be careful to not sort sections of your data while leaving other 
sections unsorted, when you actually wanted to sort everything together. 
 
 
 
 
 


